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How To Setup and Configure Your Email Clients

Before you can officially use email on your domain, you will need to create the email account with
your chosen email ID and password. Once that’s done, you can access it using either webmail (web-
based email) or email client like Windows Mail, Outlook, etc.

Setting Up Email Account
Setting up email account involved a few simple steps.

1. Login to your Hosting Cpanel by pointing your browser to yourdomain.com.my/cpanel (replace
yourdomain.com.my with your actual domain name). The username/Password was sent to your
registered email when you signed-up for the hosting. If you have changed the password, please make
sure you keep it safe and handy for future access.
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Username

Password

i

2. Once you have successfully logged-in to Cpanel, look for “Email Accounts” located under “Mail”
section. Click on the “Email Accounts” icon.
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3. Follow the steps depicted in the screenshot below to create your email account. If you need to
create more than 1 email accounts, just repeat the same process below.

- ™8 Gpanel Accelerated,

CPANEL 11

24 Email Accounts

In this area you can manage the email accounts associated

Step 1: Enter your desired email
’ ID here

B @ | I — —
Password: “ Step 2: Enter your desired
Password (again): password
Strength (why?): Very Weak (0/100) | Password Generator |
Mailbox Quota: I'éll 1000 Al
@ e “ Step 3 (Optional): You may specify the
. email quota for this account or use the
m' default setting. (uote: Email quota will be counted
towards your total hosting disk space. Make sure total
: quota you set for email accounts do not exceed the total
el iR MI hosting space provided)
AcgBNT @ DOMAIN UsAcGE / QuoTa T 9% RCTIONS
Click "Create Account” button to 0/ co mB Change  Change .. Mgrew
Password Quota

confirm

Email creation process is now completed. You can now access your email either using (i) Webmail or
(ii) Email clients (eg Windows Mail).

+
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Accessing Your Email
(i) Webmail

Using Webmail is the fastest and easiest way to get access to your email. With webmail, you can get
access to your email anywhere, anytime as long as you have an active internet connection. To access
to webmail, just go to yourdomain.com.my/webmail (replace yourdomain.com.my with your actual
domain name). Enter your email address and password.

i+ F-1alaab-

/
LA A4 4 1 21" 11

Email Address

Password

You will be prompted with 3 options (i.e Horde, RoundCube, and SquirrelMail) which are “tools” you
can use to read your email. We recommend using “Horde”.

Home HELP  LOGOUT

cPanel Accelerated,

CPANEL 11

You are logged in as

Xkhorde  roundeube P

open source webmall software

Read Mail Using Horde R-e.ac-i-MaiI .Usi-né- Rc;t.mdcuhe Read Mail Using SquirrelMail
[ Enable AutoLoad ] [ Enable AutoLoad ] [ Enable AutolLoad ]
2 = 4 X 24 A
Change Forwarding Auto Configure
Password Options Responders Mail Client Email Filtering Emadiiface

Home ™ Trademarks ™ Help ™ Documentation " Logout

(ii) Email Clients

Email clients in layman term referring to software that allows you to read your email by downloading
it to your computer. You need an internet connection to connect to the server. This option requires
settings in your email clients. Different software has different interface but the core settings are the
same.
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Configuring Email Clients

Below are the steps to configure email clients:

(a) Windows Mail
(b) Outlook Express

(c) Microsoft Outlook 2010

(a) Windows Mail

1. On the Tools menu, click Accounts.

il Inbox - Windows Mail

W Create Mail ~

Fl Lecal Falders
i Inbox
¥ Outbox
* Sent ltem
o Deleted it
&% Drafts
% Junk E-my
2 Microzeft Co|

Eile  Edit j[lmMe;;age Help

Send and Receive
Synchronize All

Windews Contacts...
Add Sender to Contacts

Windows Calendar
Message Rules
Newsgroups...
Accounts...

Junk E-mail Options...
Options...

Ctrl=Shift-C

Chrl=Shift=L

Chrl=W

[ Search

-

Subject

=3 fon"
o

M. Welcometo Windowshail

Configures your accounts.

\Welcom eto

Windows* Mail

i =msoe@microsof com= Teoc Mew Windows Mail

s

2. Click Add.
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Internet Accounts

Set up new e-mail accounts or newsgroup subscriptions by clicking Add.
To make changes, export, or remove an account or subscription, select it first,

Mews

g_# Micraseft Cammunities (default)
I

msnéws.microsor.com

Directery Service

Add...

Remave
Praperties

a5 Default

Import...
Export...

Set Order...

3. Click E-mail Account then click on Next.

Select Account Type

What type of account would you like to add?

;ﬂ E-mail Account
i_si Mewsgroup Account

i:l : Directory Service

What infarmation do [ need to 282 up my sccount?

(Camcer]

4. In the Display name box, type the name you would like others to see when they receive

messages from you. Click Next.
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|
Your Name
When you send e-mail, your name will appear in the From field of the cutgeing message.,
Type your name as you would fike it to appear,
Display name: |
Fer example: John Smith
Where can | g-rail account ir nation
Cancel |

5. In the E-mail address box, type your complete email address. Click Next.

|
Internet E-mail Address
Your e=mail address is the address cther pecple use to send e-mail messages to you.
E-mail address: |
For example: someone@microsoft.com
Where can 1 find my e-mail account information?
Cancel |

6. Ensure that the Incoming mail type is set to POP3. In both the Incoming mail and Outgoing

mail boxes, type mail.yourdomainname (i.e. mail.firstonline.net). Click Next.
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=5
Set up e-mail servers
Inceming e-mail gerver typs:
POP3 -|
Inceming mail (POP3 or IMAP) server:
mail.yourdomainname
Qutgoing e-mail server (SMMTP) name:
mail.yourdomainname
V| Qutgoing server réquines suthentication
Where can | find my e-mail server information?
(o)
7. In the Password box, type your email address password. Click Next.
pt|
Internet Mail Logon
Type the account name and passwerd your Intermet service provider has given you,
E-rail username: userl 234
Password: |
7| Rermember password
(e

8. You should see the following screen; check the Do not download my e-mail and folders at

this time box, then click Finish.
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o

Congratulations

Te save these settings and download your e-mail, click Finish.

] Do not downlosd my e-mail ot this time

You have successfully entered all of the information required to set up your account,

Finish Cancel |

9. You should now end up at the Internet Accounts screen; double-click on your e-mail

account.

Internet Accounts

Set up new e-mail accounts or newsgroup subscriptions by clicking Add.
To make changes, export, or remove an account or subscription, select it first,

Mail -~
S uzerl 234 email.umn.edu (default)

g USErL234 Bumn.edu

News e
3_* Micreseft Ccmm_!.mities {default)

micresoft.com

Directory Service ~

Close

10. At the top of the Properties window that appears, click on the Advanced tab and verify

your settings are the same as in the image below.
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;.,; userl234.email.umn.edu Properties

| Gererml | Servers | Conmection | Security | Advanced |imap |

Server Port Mumbers
Qutgoing mail (SMTP): 587
[¥] This server reguires a secure connection (55L)
Incaming mail (IMAP}: 110
[¥] This server requires a secure connection (55L)

Server Timecouts

Shart [ Long 5 minutes
Sending
[] Break apart messages larger than = KB
OK || Cancel || eply

*Outgoing Mail (SMTP):
Streamyx, Celcom & P1 users: 587
Digi & Maxis users: 25

11. Now click on the IMAP tab and, in the Root folder path: blank, enter mail/. Also uncheck

the box for Check for new messages in all folders.
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| General | Servers | Connection | Secuity | Advanced | IMAP |

Folders

Root folder path:

[7] Check for new messages in all folders

Special Folders
Store special folders on IMAP server

Sent tems path: Sent Itermns
Drafts path: Drafts
Deleted ltems path:  Deleted Ttems

Junk path: Junk E-mail

[ ok ][ cance || ooty |

:J webma00L.email.umn.edu Properties

12. Click Ok to save all of these settings, then Close to exit the Internet Accounts window.

Windows Mail will now ask you if you would like to retrieve your mail.

o

2 Inbox - Windows Mail [=]le]lE=]

W Create Mail  ~ @ Reply #% Reply All # Forward :;u . ‘Sen-i-'F:x_-n:!r.-'l_- o

i La.caiFnlders 1 % Frem Subject
= Inbox I Microsoft Windows M... Welcome to Windows Mail

8 Outbox

J Sent ltems
o Deleted ltems
& Drafts i
& Junk E-mail Windews Mail
£ userl234 email.umn.edy ) "
I3 Microseft Communities] i Weuld you like to dewnload foldess fram the mail
£ server you added?

[ To: New Windows Mail_.,

n s

Welcome to

Windgwg'—_Mail

1 message(s), 0 unread L3 Working Online

Congratulations, you have successfully set up Windows Mail to handle your e-mail!

+
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(b) Outlook Express

1. Start Outlook Express, and on the Tools menu, click Accounts.

If the Internet Connection Wizard starts up automatically, skip ahead to step 3.

Hewagn bl
- St e Biores " L

Syrcheonae Wl
Syachrtras Fakder

cidress Bock.

Tig of the day ®

Salect 3 partiodlar fant ar pisce of

Chek: th Tewls mesu, clck
Optiens, Pean chek the Compose
tab and Mk Four chaises fram

| Hemsgroups

Contacts * o | Contacts

There are na cordacts 1o Seplay. Chil.
Oy Nt aits 0 Choale & fv CORLSCT
B gnen the Addness Rati.

B find Bacgle...

I Wiren Costheak Expeass stars, { dereamly T mvy b

Ml TR 10 J0R RS SRR,

G o

2. Click Add, and then click Mail to open the Internet Connection Wizard.

Internet Accounts

Mews...
Directory Service, ..

A Mail | News | Diectoty Sesvice|
Account Type Connecton
ﬁ.ﬁ.{:ﬂ»‘e Diectory  direchory senvice Local Area Metwark -
Biglaol Internel .. dilecton seivice Lioveal Area Melwork Propesties
WenSign Inteinet . directon seivice Local Area Melwork
Whowhere Inter...  directony sevice Local Area Metwork

JE

Set Order...

Claiza

3. On the Your Name page of the wizard, type your name as you want it to appear to everyone
who gets e-mail from you, and then click Next. Most people use their full name, but you can

use any name—even a nickname—that people will recognize.
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Internet Connection Wizard

Your Name

Whet you send e-mail, pour hame will appear in the From field of the outgoing meszsage.
Type vour name as you would like it to appear.

Dizplay name:; Ifirstonline

For example: Jaohn Smith

[ hest » ][ Cancel ]

X

4. On the Email Address page, type your e-mail address, and then click Next.

Internet Connection Wizard

Internet E-mail Address

'our e-mail address iz the address other people uze to zend e-mail meszages to you,

E-mail address: [sales@firstonline.neﬂ

For example: someone@microzoft.com

¢ Back “ Mest ][ Cancel

5. On the E-mail Server Names page, fill in your ISP information, and then click Next.
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Internet Connection Wizard

E-mail Server Hames

My incoming mail server is a |F'I:|F'3 | SEIYEL
|

Incoming mail [FOP3, IMAR or HTTP] server:

An SMTP zerver iz the server that iz uzed for vour outgoing e-mail.

Outgoing mail [SMTP) zerver:

[ < Back ][ Mest > ][ Cancel ]

Incoming Mail Server: mail. yourdomainname (i.e. mail. firstonline.net)
Outgoing Mail Server: mail. yourdomainname (i.e. mail. firstonline.net)
6. On the Internet Mail Logon page, type your account name and password.

Internet Connection Wizard

Internet Mail Logon

Type the account name and pazsword vour Intermet service provider has given you,

Account name: | sales |

Paszward: |sssssssnns

Remember passwaord

If wour Intemet zervice provider reguires wou to uze Secure Pazzword duthentication
[SPA] to access your mail account, select the 'Log On Using Secure Pazzword
Authentication [SPA) check bos,

[ Log on using Secure Password Suthentication [SP)

[ < Back ” Mewt > ][ Cancel

7. Click Next, and then click Finish.
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]

Internet Connection Wizard

Congratulations

You have successfully entered all of the infarmation required to set up your account.

To zave these gettings. click Finish.

[ < Back “ Finizh ] [ Cancel

You're ready to send your first e-mail!
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(c) Microsft Outlook 2010

1. First of all launch MS Outlook 2010 application from the start button.

Microsoft Outlook 2010 Startup

\Wikcoma to the Micresoft Qutiook 2010 Startup Wizard, which will guide you through the:
process of configuring Microsaft Outiock 2010.

2. Navigate to File > Info category, here from the Account Settings option, click the drop down
button and choose Add Account button.

@i 902 . i —— o — - Outlook Today -
m Home Send / Receive Folder View
. -
_ Account Information
- No account available. Add an e-mail account to enable additional features.
v Add Account
Info - *
Open
L Account Settings
Print a‘LLl Madify settings for this account and configure additional connections.
L O]
Account
Help Settings -
- : =-| Account Settings...
Options 1 o
kd Opt a_‘u Add and remove accounts or change
E Exit © existing conmection settings.
—\':; Manage the size of your mailbox by emptying Deleted ltems and
archiving.
Cleanup
Tools ~

3. Select "Manually configure server settings or additional server types"

Copyright reserved by First Online (M) Sdn Bhd 16| Page



How To Setup and Configure Your Email Clients

Auto Account Setup
Connect to other server types.

E-mail Account

| Text Messaging (SMS)

@ Manually configure server settings or additional server types

4. Fill-in the blank with the following info (replace with your email ID).

Your Name

The name that appears on the messages you send.
E-mail address

YourlnternetID@yourdomainname (i.e. sales@firstonline.net)
Account Type

POP3
Incoming mail server

mail.yourdomainname (i.e. mail.firstonline.net)
User Name

Full Email Address (i.e. sales@firstonline.net)
Password

your email password
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5. Click at "More Settings" and check this box "My Outgoing server (SMTP) requires

-
Add New Account

Internet E-mail Settings

User Information

Your Mame: Your Mame

E-mad Address: info Bexample.com

Server Information

Account Type: poes |_TJ
Incoming mad server: mai.example. com

Dutgong mal server (SMTP): | mal sxamphe.com
Logon Information

Liser Hame: info Qexarple.com
Password: e
[¢] Remember password

[T Require logon using Secure Password Authentication (SPA)

Each of these settings are requned to et your e-mal scoount working.

Test Account Settings

After flling out the information on this screen, we
recommend you test your account by dicking the button
below, (Requires network connection)

[¥] Test Azceant Settings by choing the Mext butten
Deliver new messages to:
@) New Outiook Data Fie
{2 Bxisting Qutiock Data Fie
Browss

<gack |[ mext> | [ concel

l

authentication"

Then click at "Advanced" to configure Incoming & Outgoing Server.

-
Internet E-mail Settings

!E_i -!1

General | Outgoing Server | Connection | Advanced

My outgaoing server (SMTP) requires authentication

(@) Use same settings as my incoming mail server

S— ;
i) Log on using

User Mame: |

Password: |

[¥] remember password

[]Require Secure Password Authentication (SPA)

() Log on to incoming mail server before sending mail

J [ canel ]|
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F ~
B y m—— o -—
Internet E-mail Settings - E

| General | Outgoing Server | Connection | Advanced

Server Port Numbers

Incoming server (POP3): 110 Use Defaults
[] This server requires an encrypted connection (S5L)
U Outgoing server (SMTP): 587

i Use the following type of encrypted connection: ! None g‘ |
! | server Timeouts

] Short ~J Long 1minute

M Delivery

" ["]Leave a copy of messages on the server .

! [ IRemove from server after 10 || days

[ Iremove from server when deleted from 'Deleted Items'

l ok J[ conce l|!|

&
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